Scheduling and Delivering Highly Formatted Reports Using Oracle Discoverer and Business Intelligence Publisher

An Oracle White Paper
March 2009
Scheduling and Delivering
Highly Formatted Reports
Using Oracle Discoverer and
Business Intelligence Publisher

Introduction ....................................................................................................... 3
Benefits of integration ...................................................................................... 4
Configure oracle discoverer and bi publisher ............................................... 4
  1. Configure Discoverer with Application Server in SSO mode.............. 5
  2. Configure Discoverer Web Services.................................................... 5
  3. Configure BI Publisher with Discoverer Web Service ..................... 10
Create and Deliver a BI Publisher Report based on a Discoverer Worksheet......................................................................................................... 10
  1. Creating a report in BI Publisher Web Interface............................... 13
  2. Creating Layout Templates ............................................................... 17
  3. Schedule and Deliver Discoverer Reports using BI Publisher ........ 25
Conclusion........................................................................................................ 28
INTRODUCTION

Oracle Business Intelligence Publisher (BI Publisher, formerly XML Publisher) is an enterprise reporting solution to author, manage, and deliver all types of highly formatted documents eliminating the need for costly point solutions. Built on open standards, IT staff and developers can create data models against practically any data source and use BI Publisher APIs to build custom applications leveraging existing data sources and infrastructure. End users can easily design report layouts using familiar desktop tools, dramatically reducing the time and cost needed to develop and maintain reports. Extremely efficient and highly scalable, BI Publisher can generate tens of thousands of documents per hour with minimal impact to transactional systems. Reports can be viewed online or scheduled for delivery to a wide range of destinations.

Oracle Business Intelligence Discoverer is an intuitive ad-hoc query, reporting, analysis, and Web-publishing tool that empowers business users at all levels of the organization to gain immediate access to information from data marts, data warehouses, online transaction processing systems and Oracle E-Business Suite.

By taking advantage of the integration available with the latest versions of BI Publisher and Discoverer you will be able to create highly formatted reports that include multiple visualizations based on data from Discoverer worksheets. You will also be able to schedule those reports to be executed and delivered to printers, fax machines, email, WebDAV and ftp destinations.
BENEFITS OF INTEGRATION

Oracle BI Publisher 10.1.3.3 includes the ability to use Oracle BI Discoverer worksheets as the data set for a report. This provides three key benefits to Discoverer users, who will now be able to:

- Create highly formatted reports:
  - Rich formatting capabilities: Use Oracle BI Publisher template builder for Microsoft® Word to use the formatting features of Microsoft Word to format content.
  - Rich layout capabilities: Use the Oracle BI Publisher Template Builder for Microsoft Word to use the document layout and formatting features of Microsoft Word.

- Schedule execution and Delivery of reports to wide range of destinations:
  Schedule frequency (Once, daily, weekly, immediately) and delivery destinations (Email, FTP, WebDAV, FAX, Printer) can be configured in Oracle BI Publisher, allowing Discoverer content to be generated and distributed on a scheduled basis.

- Generate reports in a greater range of formats: Create multiple templates per Discoverer worksheet: Layout templates in BI Publisher can be built using familiar desktop applications such as Microsoft Word and Adobe Acrobat®. Oracle BI Publisher plug-ins are provided to help the report designer to build the layout they want in their favored application.

This document describes how to:

- Configure BI Discoverer and Oracle BI Publisher to work with each other
- Create, Schedule, and Deliver BI Publisher reports based on Discoverer Worksheets

CONFIGURE ORACLE DISCOVERER AND BI PUBLISHER

Depending on your Application Server version you will have to apply some patches to obtain Discoverer Web Services enabled, so please consult Oracle Support to obtain the corresponding patches that apply to your case.

The following configuration is based on BI Publisher version 10.1.3.3 (including BI Publisher's template builder for MSFT Word) and Application Server Update 10.1.2.3 (which includes Discoverer Plus 10g (10.1.2.55.26)).

Once you have installed the software you will have to perform the following steps to integrate Oracle BI Publisher and Oracle Discoverer:

1. **Configure Discoverer with Application Server in SSO mode**: BI Publisher integration requires an integrated SSO-enabled Discoverer instance. When Discoverer is SSO-enabled then every Application Server
user can create their own Discoverer private connections and use them in BI Publisher when creating BI Publisher’s report.

2. Configure Discoverer Web Services: This step sets up the trusted users in BI Discoverer to be used within BI Publisher.

3. Configure BI Publisher with Discoverer Web Services: This step sets up the parameter values and proxy user for BI Publisher to make use of Discoverer Web Services.

1. Configure Discoverer with Application Server in SSO mode

Discoverer Web Services operates only in a SSO environment\(^1\). Only the SSO user is authenticated and Discoverer Private and Public connections for that user can be retrieved\(^2\).

To enable Single Sign-On for Discoverer, open the file

\(<\text{ORACLE\_HOME}>\text{\textbackslash apache\textbackslash apache\textbackslash conf\textbackslash mod\_osso.conf}\>

in a text editor and add the following text to the end of the file:

\(<\text{Location /discoverer/plus}>\)
  \ require valid-user
  \ AuthType Basic
\(<\text{/Location}>\)
\(<\text{Location /discoverer/viewer}>\)
  \ require valid-user
  \ AuthType Basic
\(<\text{/Location}>\)
\(<\text{Location /discoverer/app}>\)
  \ require valid-user
  \ AuthType Basic
\(<\text{/Location}>\)

Re-start the Application Server Middle Tier.

2. Configure Discoverer Web Services

Discoverer Web Services in release 10.1.2.3 requires four additional manual steps described below\(^3\)

a) Create an OID Container for Discoverer Webservices:

To create the Oracle Internet Directory container (A new entry in OID) for the Discoverer Web Services perform the following steps. Confirm that the Application Server Infrastructure Tier is up and running (infra DB and

\(^{1}\) This will change for Discoverer 11g.

\(^{2}\) For specifics see: "How to enable and disable Single Sign-On for Discoverer" in the Oracle® Business Intelligence Discoverer Configuration Guide or follow the Metalink’s Note 300229.1

\(^{3}\) See Readme for patch 5983622 (upgrade to Application Server 10.1.2.3)
Application Server Infra), set Middle Tier ORACLE_HOME, and create the Oracle Internet Directory Container:

DOS> opmnctl status
DOS>set ORACLE_HOME=c:\OracleASBI
ORACLE_HOME\discoverer\util > createoidcontainer orcladmin ias_admin1

Note: ias_admin1 is the password we used when we installed the Infrastructure and the middle tier.

b) Update the Java Policy

Update Java policy file by adding the following permission in the ORACLE_HOME/j2ee/OC4J_BI_Forms/config/java2.policy file:

```
grant codebase
"file:${oracle.home}/j2ee/OC4J_BI_Forms/application-deployments/discoverer/.*"
{permission java.lang.RuntimePermission "oracle.discoverer.connections"; }
```

c) Define a trusted user to access the Discoverer web services

Define a trusted user in AS Middle Tier which BI Publisher will use in the web services call to Discoverer. Here we define two trusted users: bipuser and video5.

These users and group are created using Oracle Application Server Enterprise Manager for your BI & Forms installation. After logging into Application Server Control, please navigate to the following location:

```
OC4J_BI_FORMS \ Applications \ Discoverer
```

Select the ‘Security’ link and you should see the following page:
Select the ‘Add Group’ button to add a group called ‘sr_users’ – make sure to check both boxes for the group as below:

You should now see the following:

Select the ‘Add User’ button to add a single user, in this example we are adding users called ‘bipuser’ and ‘video5’. Any of these users can be used as proxy for BI Publisher when configured later to access the Discoverer Web Services. Add these users to the group ‘sr_users’ created earlier:
Do the same for user video5/video5 and you should now see the following:

\[
\begin{align*}
\text{d) Map group and users to an application specific role} \\
\text{The next step requires an edit of a file to map the users and role you just created to a pre-existing Discoverer specific role called `sr_users`.}
\end{align*}
\]

Open the file

\[
\text{ORACLE_HOME/j2ee/OC4J_BI_Forms/application-deployments/discoverer/orion-application.xml}
\]

In a text editor and add the following:

\[
\begin{align*}
<\text{security-role-mapping name="sr_users"}>
&<\text{group name="jazn.com/sr_users"}>
&<\text{user name="jazn.com/bipuser"}>
&<\text{user name="jazn.com/video5"}>
</\text{security-role-mapping}>
\end{align*}
\]

As shown in this screenshot.

Note: The pre-existing role "sr_users" is defined in the file:

\[
<\text{ORACLE_HOME}/j2ee/OC4J_BI_Forms/applications/discoverer/discoverer/WEB-INF/web.xml>
\]
After this you restart the OC4J_BI_Forms process and navigate to OC4J_BI_FORMS > Applications > Discoverer > Security and you should see the following:

![Security Screenshot](image)

e) **Add** the following entry to the **configuration.xml** file to control the configuration parameters:

```
<ws logLevel="debug" maxSessions="20">
  <enableWS status="true"/>
</ws>
```

In the preceding entry, logLevel specifies the logging level, maxSessions specifies the maximum number of Oracle Discoverer sessions that can be active at the same time (the recommended value is 20), and enableWS specifies whether the Oracle Discoverer Web Services is enabled.

f) **Verify access to the Discoverer web services**

To test the definition of the trusted users and verify they access Discoverer Web Services go to

```
http://<discoverer machine name>:7778/discoverer/wsi
```

Enter user created / pwd (e.g. bipuser / bipuser1 and video5/video5 should work). If you successfully login then you will see a webpage like this:
3. Configure BI Publisher with Discoverer Web Service

Login to BI Publisher as a user with Administrator privileges and navigate to the Admin tab. In the lower right, under Integration, click on "Oracle BI Discoverer".

Enter the details of the Discoverer installation. Any of the dedicated users defined previously (either bipuser/bipuser1 or video5/video5) has to be defined in BI publisher. BI Publisher must be restarted as well as Application Server so that changes take effect.

CREATE AND DELIVER A BI PUBLISHER REPORT BASED ON A DISCOVERER WORKSHEET

So far, we have configured Discoverer to work integrated as new data source for BI Publisher. Before we can proceed we need to define a SSO user under Oracle Application Server so that it can access Discoverer reports.

We can either use Oracle Directory Manager or the Oracle Identity Management Self-Service Console web interface for OID Delegated Administrative Services (oiddas). The easiest and quickest method is to your OIDDAS. For example: http://chaos.us.oracle.com:7777/oiddas/
Login as administrator (normally orcladmin/ias_admin1, the password depends on the value you used during the Application Server installation) and click on Directory tab. Click on “create” and create the 'biptest/biptest1' SSO user:

At this point we have to make a decision of BI Publisher’s users management. We need to decide what kind of Security model for BI Publisher’s we will use:

a) If we use LDAP security Model then we can leverage the Oracle Internet Directory (OID) and associate the user (just created) to one of the XMLP predefined groups 4 then your default group would look like for example:

```
User default group [XMLP_ADMIN]
```

b) or If we use BI Publisher’s security mode (XDO) then SSO users need also to be defined in BI Publisher, so that they can create, schedule, view BI Publisher’s reports based on Discoverer Data.

---

4 For more details on this configuration see: BI Publisher integration with LDAP
For simplicity, we will use the latter and therefore we need to define the user “biptest / oracle ” in BI Publisher.

**Note:** When creating the user in BI Publisher, consider if the user will create reports, execute or schedule them. It is always advisable to define new Roles and associate roles to users in this manner we can also share Folders and data sources.

We have also defined three new roles: **Developer** (who can develop new reports), **Scheduler** (who can only schedule reports) and **User** (who can only view reports)

![BI Publisher Interface](image)

We have the following users: Administrator (BI Publisher's administrator), biptest (user to create new reports), janicama (user who can only view reports).

![User Table](image)

We have the following user and role assignments:

<table>
<thead>
<tr>
<th>BI Publisher's User Name / Password</th>
<th>Role Names</th>
<th>BI Publisher's Role</th>
<th>Actual role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator/Administrator</td>
<td></td>
<td>BI Publisher Administrator</td>
<td>BI Publisher Administrator</td>
</tr>
<tr>
<td>biptest / oracle</td>
<td>Developer, scheduler</td>
<td>BI Publisher Developer,</td>
<td>Creates BIP reports, Schedule</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BI Publisher Scheduler</td>
<td>reports</td>
</tr>
<tr>
<td>janicama / janicama</td>
<td>User</td>
<td>BI Publisher Excel Analyzer, BI Publisher Online Analyzer</td>
<td>View BIP reports</td>
</tr>
</tbody>
</table>

The BI Publisher's users “biptest” and “janicama” need also to be SSO users in Oracle Application Server so their corresponding private connections and public

---

5 Notice the password is different as the user's name “biptest” must only be common.
connections will be available when they create BI Publisher reports from Discoverer data.

1. Creating a report in BI Publisher Web Interface

We will start showing the Discoverer reports created by the SSO user biptest/biptest1.

We also show here a screenshot of the user biptest/biptest1 after creating a Private connection in Discoverer, this connection will be carried to BI Publisher when user biptest logsins to BI Publisher and creates reports based on Discoverer Worksheets as data source.

Now, to create our BI Publisher report based on this Discoverer Worksheet, connect to Oracle BI Publisher through your browser. It should look like this http://myserver.company.com:7779/xmlpserver and login as biptest / oracle (BI Publisher user as defined above with roles for scheduling and developing reports).

Navigate to or make a directory to hold the report you want to create.
Click Create a new report in the Folder and Report Tasks frame on the left side of your browser page. Give it a name “Video Stores” and click Create. The report will appear on the right hand side of the screen.

Click the **Edit** link the under the report name.

Select Data Model from the Report tree and click the New button at the top of the tree to create a new Data Set.

Under the **General Settings** section of the Data Set, optionally name the data set and select **Oracle BI Discoverer** in the Type field.

Under the **Details section** of the Data Set, click on the flashlight icon. Navigate to and select the Discoverer connection that owns the worksheet you want to use in your report.
Note: At this point the list of **discoverer connections** (see more about this here) shown will be associated to the SSO user that is creating this report.

Once you have selected a connection, click on the flashlight to the right of the Worksheet field. Navigate to and select the workbook and then the worksheet you want to base your report on.

Note that the fully qualified path to the worksheet is entered in the Worksheet field.

Note that regardless of whether the Discoverer worksheet is a tabular or crosstab layout, the Discoverer Web Service will return the data to Oracle BI Publisher as flat tabular data. This is by design so that you can take full advantage of the layout capabilities in BI Publisher. You can layout this data as a crosstab in BI Publisher.

Save your report by clicking the Save icon on the upper left side of the page, below the navigation links to the report.
Once the report is saved, click the View link (upper right corner) to see that the Discoverer Worksheet you selected returns data to the report. If your worksheet contains parameters, you may need to select values other than the default and click View to get the worksheet to return data.

You have successfully created a report with a data model based on a Discoverer Worksheet.

Notice that because of the roles granted to “biptest” user (Scheduler, Developer) you do not see the other buttons “Analyzer” or “Analyzer for Excel” which are associated to roles such as Online Analyzer, Excel Analyzer respectively.
2. Creating Layout Templates

Oracle BI Publisher provides several types of layout templates. The most common are RTF layout templates created using the Template Builder. You can also create PDF templates in Adobe Acrobat, eText templates, and Adobe Flex templates. This document will briefly describe only the process of creating an RTF layout template. See the Oracle Business Intelligence Publisher Report Designer's Guide for more details on creating other types of templates and for more details on RTF templates.

Note that even though a layout template created with the Template Builder is in RTF format, at runtime the layout template is converted to Extensible Stylesheet Language Formatting Objects (XSL-FO) and the report output format can be PDF, HTML, Excel, PowerPoint, as well as RTF.

There are two methods you can use to create an RTF layout template for a report:

- **The Online method** – meaning connected to the Oracle BI Publisher report server. This method allows you to connect directly to the report server to download report data. It is suitable if your report has been set up to provide a reasonable amount of data.

- **The Offline method** – meaning not connected to the Oracle BI Publisher report server. Using the offline method, you will generate sample XML data for your report. This method has the advantage that you will be placing no load on the report server or underlying data source while creating your layout. It is also the preferred method if your report returns a large amount of data or has parameters that need to be set to limit the amount of data returned or to ensure that some data is returned.

Creating a Layout Template using the Offline Method

*a) Generate sample XML data.*

From the Oracle BI Publisher web interface navigate to the report you want to create a layout against and select View to see the report output.

If there are parameters that can be set to either reduce the amount of data or to ensure that some data is returned, set the parameter values and click the **View** button. Then select Data from the pull down menu to the left of the View button and click the **Export** button.

A new browser or tab will open containing the exported XML data.
Using the web browser File menu, save the file with an XML extension.

If the size of the XML file is still excessive, you will want open it in a text editor and remove data from the file to get it to a smaller size. Be sure to preserve the tag structure in the file. You will also want to make sure you have enough data so that previewing your report will show how the actual report will be generated. For example, if you plan to group data by Year, be sure to include some data from at least 2 years so that you can confirm that the grouping displays as you want.

**b) Upload the sample XML data file to the Template Builder**

After you generate the sample XML data file move it to the machine where you are running the Template Builder. From the Oracle BI Publisher menu or the Template Builder toolbar, load the sample XML data.

c) **Create a layout template**

Now that you have uploaded the sample XML data to the Template Builder, you can use the Template Builder Insert menu and toolbar to launch wizards and dialogs that help you create your layout template. You can also insert whatever boilerplate text you want as well as format fields and tables using standard Microsoft Office Word layout and formatting functionality.

The following figure shows the Template Builder Insert Toolbar:
You can also manually include data field tags and other markup to your template using BI Publisher’s simplified tags for XSL expressions. These tags associate the XML report data to your report layout. If you are familiar with XSL and prefer not to use the simplified tags, Oracle BI Publisher also supports the use of pure XSL elements in the template.

**Inserting a graph:**

Place the cursor at the beginning of the page and go to BI Publisher’s Menu: Insert → Chart

and you will get a dialog window similar to this

Now, **drag & drop** the values from the Data group: *Profit Sum, Region, Year, Department* to the right hand side into *Values, Labels, Series* respectively. Also select *Aggregation as SUM* and Check the boxes for “3D” and “Gradient” and click **OK.**
Similarly insert another chart next to the one above with the following settings and click OK.

Printing Rows of data:

To print rows of data we will make use of the Wizard. Go to BI Publisher's Menu and select **Insert ➔ Table Wizard** and you will get a wizard. Successively select the values as shown in the pictures:
After finishing the Table Wizard your document will look like the following:

Save the layout template as an RTF file:

Finally, from the File menu, select Save As “VideoStores.RTF”. Be sure to set the type to Rich Text Format (*.rtf).
d) Preview the report output

After you have created and formatted your layout, you can preview it in the desired output format from the Template Builder to confirm that you have created the layout exactly as you want. Previewing will generate the output document, merging the layout template you just created with the data that is loaded in the Template Builder.

Select the desired output format from the Preview menu item on the Template Builder toolbar or from the Oracle BI Publisher menu.

You will see the generated document in the application suitable for displaying the requested output format. Here is an example previewing PDF output in Adobe Reader:
c) Upload the RTF template to the report.

Once you have made the changes you want to your RTF template, save it to the file system. Return to the Oracle BI Publisher web interface and navigate to the report associated with this layout template.

From within the report **edit page** of the Oracle BI Publisher web interface, select **Layouts** from the Report tree. In the **Manage Template** Files section of the Create Layouts frame, click the **Browse** button to select the RTF template. Once the RTF template is selected and the **Upload** Template field is populated with the full path to the RTF template, click the Upload button.
You will then see the uploaded template in the Manage Template Files section of the page.

Create a named layout and associate it with the template file.

From the report tree, with Layouts still selected, click the **New button** at the top of the report tree. This will create a new layout.

Provide a name for the layout and associate it with the template file you uploaded. You can also optionally determine what output formats are available for this layout.

**f) Save the report.**

Be sure to save the changes you have made to the report by clicking the Save button below the path to the report.

**g) Test the template with the data**

Once you have uploaded the template into the report VideoStores, click on the View button and Select HTML as output and click on View again. The result
should be similar as the one you had when prepared with Template Builder for Windows.

![Image](image.jpg)

3. Schedule and Deliver Discoverer Reports using BI Publisher

Reports based on Discoverer data can also be scheduled by using the BI Publisher Enterprise Schedule feature. The Schedule feature enables specification of the following information:

- Report parameters, such as template name and output format.
- Job properties, such as job name, report locale, and report time
- Notification parameters, if the email delivery option is enabled.
- Run-time options.
- Destination delivery options.

Follow these steps to schedule the report of Discoverer data:

1. With the report open in BI Publisher Enterprise, click the **Schedule** button.

2. In the Schedule Report window, specify or select the following:

   A. In the Report Parameters section, select the desired Template and Format for the report.
B. In the Job Properties section, specify an appropriate job name for the scheduling job, and select the other options that meet your specifications.

C. In the Notification section, enter one or more email addresses and specify when you want a notification to be sent. Note: This section is optional.

D. In the Time section, select the appropriate run time. In the example, Run Monthly is selected. Then, specify the secondary options for the selected run time.

E. In the Destination section, select the desired option. If you have more than one choice configured for a destination type, then you may select from among those choices.

The next example assumes the Email delivery option has been selected and previously configured. Please use the appropriate values that correspond to your environment:
F. Click **Submit**.

3. Once your report job has been scheduled, you can choose to suspend, resume, or delete the job at any time.

When your scheduled job runs you will see the following status in the Schedules → History jobs:

And when it finishes successfully you will see the following status:

If the report is delivered successfully by Email then you should receive it like this:
CONCLUSION

With the integration with BI Publisher now Discoverer users can take advantage of what BI Publisher offers. It allows the Discoverer users to develop highly formatted report layout easily and flexibly for the existing Discoverer worksheets. The users can also use BI Publisher’s scheduling and delivery functionalities to schedule the reports generation and distribute the reports to various type of delivery audience.

The integration enhances your existing reporting system with Discoverer to meet today’s complex reporting requirements with a complete reporting solution.